
 
 

      

  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Manual Compustam  
Manger for all your pigeon data 

 

Distributor UK  BACK-UP DATA 
Compuclub Kantoor   
Info@compuclub.nl  Standaard back-up 
Technical question +31(0)20-2134115 
Other questions     +31(0)20-2134115 

 On a USB-stick or  
Compustam-Cloud  

   

NEW IN COMPUSTAM 9.26 AND HIGHER  

Online Back-up to  My Compustam-Cloud 

Updatend  o.a. Windows 10  May 2020 update and  
Oktober  2020 update 
  

 
Possible error message after upgrading 

from Windows 7 or Windows 8.1 to Windows 10 
There is no Default printer currently selected 

 
 
New  Replace Country codes  
From Compustam 9.24 and higher 

 

New in Compustam 2018 
Compustam cloud  

All family trees in the  Compustam Cloud  
This is the next step of Compuclub 
New in 2020 My Compustam-Cloud 

 
Installing Compustam from USB-stick 

For laptops and pc’s without cd-dvd-speler 
 

 
 
 
 
 
 
 

 

The most practical total program for 20 years 

Microsoft support 

Windows 7 ends 

on January 14, 2020 

https://get.teamviewer.com/pcr52ke
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What’s New 
 

Your pedigree in the Cloud  
- Upload pedigree data to compustam-cloud.nl to view them anywhere in the world in 2020 
 
 
File 
Onlne Back-up and restore to new part my Compustam-Cloud 
 
Pigeons 
New menu-item replace country codes  new from version 2019 and higher 
 
Results 
- Search for best performance of brothers and sisters of a pigeon  
- When exchanging pedigree data, the best results add to comments  
- Search for best pigeons can be searched simultaneously in several directions 
- Performance per pigeon show all levels simultaneously  
 
Print options  
- Stamps with pigeon picture in each pigeon compartment  
- For font card the font style is adjustable for ring number, pigeon name, breed, and breeder  
-Two free fields on the basis card for e-mail address and website for example  
- In pedigree cards, pigeon name, breed and breeder can be printed in a different color Hen 
screen  
 
Pigeon screen 
- in pedigree card 3 generations and 4 generations extra are the fields of the first 2 generations 
enlarged with 6 extra rules  
- When introducing new pigeons, country code is automatically fetched ld. with the standard 
country code  
-In screen Pigeons selection in the loft  
 
Pair and breeding  
-List row by batch can be sorted by date Ei-1  
-If importing young pigeon in breeding data already exists, an error message is displayed with 
which coupling number, bin number and round number this hears  
-Function in the 'File' menu and screen-breeding-breeding to update the box and loft in pigeon 
data  
-When inserting a pair, the loft and bin number is updated in pigeon file 
-In case of couples searching for shortened ring number of father and mother 
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Important notice Compustam 2018 release 9.13 and higher 

 

 

the settings required for the Compustam version 

from release 9.12+. 

 

land notatie: Dutch (Netherlands) 

short date note: dd-MM-yyyy 

 

these settings must be adjusted for (Re) installation 

profit sum 9. Then there are no more problems with importing old ones 

version. not even if you do not index or have an older update 

Compustam for Windows 7.09 or 8.02 instead of Compustam for Windows 

7.21 or 8.09. 

 

after import the possible message tdDuif can be ignored, 

close the program and restart. and the error message 

stays away. 

 

pay attention to extra mention than after installation the offered performances 

cannot be read in. (the old version "import" option does not disappear) 

 

See the following topics where the solution is described 

per operating system 

 

 

 

Error messages in Compustam 2020 and Windows 8.1 

 

Error messages in Compustam 2020 and Windows 10 

 

This problem can also occur if you want to make a backup or like you 

to request performance 

 

Important restart the PC or laptop or it will not work!! 
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installation of Compustam digital download 

 

Have you purchased a new version or an upgrade from Compustam 

then you have received an email from Compuclub with your registration from Compustam 

new about this is that from now on there is a link to the Compustam Setup (version 9) 

has been added to the registration form 

You can click on this link and it will be downloaded and if you use Windows 7 to Windows 10 

uses Street Setup in the Downloads folder 

 

There are several ways to get to the folder downloads 

1 

Click on the                                                 and at the top left is the Downloads folder 

 

 

With the Compustam Setup file go to the Setup file and this right click and "Run as administrator 

and the installation becomes started 

 

 

 

 

 

 

 

 

 

 

 

 

 

Update January 20, 2020 if you use the newest edge brouwser, switch off the 

smart screen 

and go to Downloads and swits on ‘ Ask where to save each file before 

downloading  
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installation of Compustam digital download 
 

The 2nd way is via the web browser that you use 

  

In Chrome 
 

It's at the bottom of the window 

 

  

In IE en Edge 

It's at the bottom of the window 

 

In Firefox 

 

from the toolbar 
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Compustam Cloud  
 

From Compustam 2017 there is a new component in Compustam included the possibility to 

upload your pedigree data to Compustam Cloud. With this the Compuclub takes the next step 

This development will be done in steps, first we offer you the viewing of your Stam cards, 

wherever you are. From Compustam 2020 click on 

 

The screen below appears 

 

 

Click on Upload to Compustam Cloud  

- You can also set a check mark for Upload address data,  

then the family tree data is uploaded to Compustam Cloud 

 

Important: You can upload the pedigree data here, please note that you have to upload the 

pigeon photos separately to Compustam-cloud after uploading your pedigree data after 

Compustam-cloud afterwards uploading pigeon photos active  

New in Compustam 2020: Settings to to new Ussers settings menu Cloud 

 

Go to Compustam cloud 
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Compustam Cloud  
 

To use Compustam cloud you need a Username and password. These are provided to You by 

the Compuclub if you have Compustam 2020. Compuclub uses the email address you used 

when you purchased a new or upgrade license. If you did not receive an email for Compustam 

cloud, do not forget to look in the folder of junk email or spam and put the email address in your 

address book so that you can If you are logged in in Compustam cloud you will find a 

comprehensive manual there 

 

 
 

Important to know before Uploading your data to Compustam cloud Your Compustam Cloud 

family tree data are overwritten every time Eg. if you have 100 pigeons in Compustam-cloud 

and you remove 5 pigeons from the pigeon data from Compustam 2020 and then upload again 

to Compustam cloud there are only 95 pigeons in Compustam cloud that sounds logical but you 

manage your pigeons in Compustam 2020 on your PC or laptop, money is actually what money 

always makes first backups of your data on eg a USB stick and save your registration data well 

Do not know how to make a backup on a USB stick 

A Backup or restore to a USB flash drive How do you do that? 
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Compustam Cloud Account Expired 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Compustam Cloud Account Expried   

 

You no longer have access to Compustam cloud 

You want access to Compustam cloud again 

dam You must extend Your abonoment 

Note: Compustam will still be updated 
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Compustam Cloud Account Expired 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Your subscription for Compustam-Cloud has expired. If you wabt to continue using Compustam-

Cloud you must renew your subscription . You can extend your subscription by entering your 

telephone number and your NPO membership number and then you can send the completed 

form 
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instalation 
 

Note: before importing the old version, it is wise to check the files in this 

          version first indexing via menu item File indexing files 

 

Installation 

Update Windows version 3 

Update Windows version 4 

Update Windows version 5 

Update Windows version 6 

Update Windows version 7 

Update Windows version 8 

 

Date Settings Windows 8.1 

Date Settings Windows 10 

 

 

 

Master index 

File 

Pigeons 

Results 

Breed 

Extra 

Settings 

Help 

FAQ 

 

 

 

 

Microsoft Windows 7 ends support on Januari 14 2020 

toolbar with shortcuts 
 

There is a handy toolbar in Compustam 2020 You make your choice by clicking on the image 

You can still use the menu items but the relevant components of Compustam 2020. 

 

 
 

You must install the latest version of 

Compustam on the same PC laptop where your 

current (older) Compustam version is 

 

If you have purchased a new PC laptop with 

Windows 10 to replace, for example, your old 

Windows 7 PC laptop, you must first install the 

latest Compustam version on your old PC 

laptop, otherwise the import will not work 
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Installation Compustam 2020 
 

Both new and existing Compustam users should first install the latest version of Compustam 

2020 *only applies if you have received an installation CD 

 

Installation with CD-ROM 

if you order a wwn upgrade from the 2020 season, it will be delivered on a USB stick 

unless it is delivered (order) is digital) 

Before installing, first place the Compustam 2020 CD in your CD-DVD player. Automatically 

start an installation program. * Do not start this automatically within 30 seconds. Then follow the 

following steps. ** In Windows 7 (from desktop), click U on Start Button Click on Computer and 

go to the Compustam installation CD open it (right-click and choose Open. (In Windows 7 you 

can also click Run after Open type UE: \ setup) 

 

 

 

 

 

 

 

 

 

 

 

If your CD-DVD player has a different letter, replace E with the letter of your CD-DVD player 

then click OK. Now the Compustam 2020 installation begins 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Important: Make sure your login to Windows 8.1 T/M Windows 10 with administrator 

rights than you have permission to remove or install Windows programs 
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Installation Compustam 2020 
 
Note: before importing the old version, it is wise to check the files in this 
          version first indexing via menu item File indexing files 
 
If you receive error messages during Compustam 2020 (re) installation, you can try the 
following if you have Windows 8.1 to Windows 10 on your PC or laptop. 
 
If the installation CD does boot, close it then go to your CD-DVD player. Right-click it and 
choose Open. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Then right-click W9Setup.exe and Run as administrator and Compustam 2020 starts 
 
if you order a wwn upgrade from the 2020 season, it will be delivered on a USB stick 
unless it is delivered (order) is digital) 
 
 
 
 
 
 

 
 
 
 
 
 

 

Important: Do not choose the folder where you  
Compustam for Windows version 3 t/m version 8 for Windows installed Compustam Your 
data will be overwritten!!!  
You can choose the default folder by Best to make any changes 

Important: Make sure your login to Windows 8.1 T/M Windows 10 with 

administrator rights than you have permission to remove or install Windows 

programs 
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Installation Compustam 2020 Download version  
 

 
Note: before importing the old version, it is wise to check the files in this 
          version first indexing via menu item File indexing files 
 
If you receive error messages during Compustam 2020 (re) installation, you can try the 
following if you have Windows 10 on your PC or laptop. 
 
If you received the installation version as download and it is in the Downloads folder (default 
folder where the downloads are saved in Windows versions 7 to 10 Go to the folder where the 
download is located 
 
 

 
 
 

Then right-click WSsetupENG.exe and Run as administrator and Compustam 2020 starts 
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Installation Compustam 2020 Download version  
 

You may not be notified of SmartScreen see below to resolve it 
 

 
 

Klik on more info 
 

 
 
 
 
Now you see App WSsetupENG.exe and publisher unknown publisher 
WSsetupENG.exe is not an app and just comes from Compuclub but Compuclub is not a well-
known publisher from Microsoft. Just click Run, and then the installation will just start. 
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Installation Compustam 2020 with Windows 8.1 
 

1. Touch/ Click on the desktop tile  

 
 
 
 
 
 
 
 
 
 
 
 
 
2. Click on Windows explorer  
 
 
 
 
 
 
 
 
 
 
 
3. Click on the CD/DVD player  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4 on the right the content appears, click on setup.exe with the right 
 mouse button and choose for Run as administrator, then the  
main menu appears for the compustam 2020 cd-USB-stick. you can choose for  
1 installation compustam 2020 

error messages with 

Compustam 7 and Windows 8.1 

click here 

Skip Windows 8.1 Metro interface  

In Windows 8.1 you can directly go to 
the desktop like in Windows Vista and 
Windows 7  
Right-click anyware on the taskbar 

and choose Properties 

 
 

Click the tab navigation and click 

under the heading Home screen. 

Now the Merto interface on 

Windows 8.1 wil be beaten Do not 

forget to click Apply 
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1. Click the Windows Explorer 
 
 
 
 

 
 
 
 
 
 
 
 
2. Click the Downloads if you have downloaded the 
installation of Compustam 2020 has received from 
our online store or by mail 
 
 
 
 
 
 
 
 
 
 
 
ONLY IF YOU HAVE AN INSTALLATION - 
CD/USB-stick  
3. Click on the CD-DVD player, right 
 
 
 
 
 
 
 
 
 
 
4 on the right the content appears, click on setup.exe with the right 
 mouse button and choose for Run as administrator, then the  
main menu appears for the compustam 2020 cd-USB-stick. you can choose for  
1 installation Compustam 2020 

Installation Compustam 2020 with Windows 10 
Mei 2020 update version 2004 19041.XXX 

Searching in Windows 10 has 

been changed Now you can not 

only search for files or folders, but 

also directly to the Internet (for now 

Bing is not to change) If you do not 

see the Web option click sprocket 

no. 2 and switching search online 
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1. Click the Windows Explorer 
 
 
 
 

 
 
 
 
 
 
 
 
2. Click the Downloads if you have downloaded the 
installation of Compustam 2020 has received from 
our online store or by mail 
 
 
 
 
 
 
 
 
 
 
 
ONLY IF YOU HAVE AN INSTALLATION 
 -CD/ USB-stick 
3. Click on the CD-DVD player, right 
 
 
 
 
 
 
 
 
 
 
4 on the right the content appears, click on setup.exe with the right 
 mouse button and choose for Run as administrator, then the  
main menu appears for the compustam 2020 cd-USB-aeick. you can choose for  
1 installation Compustam 2020 

Installation Compustam 2020 with Windows 10 
Oktober 2020 update version 2009 190042.XXX 

Searching in Windows 10 has 

been changed Now you can not 

only search for files or folders, but 

also directly to the Internet (for now 

Bing is not to change) If you do not 

see the Web option click sprocket 

no. 2 and switching search online 
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Installation Compustam on a pc or laptop without CD-DVD player with 
USB-Stick 

 
 
1. Place the Compustam installation CD into the CD-DVD player (PC or laptop with CD-DVD 
player) and place the USB Stick  

2. Open Windows Explorer and click the USB Stick with the right to  
 
 
 
 
 
 
 
  
  
 
 
 
  
 
 
 
 
Choose format  
3. Click Start, and then click OK  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Right- click on the installation CD and choose Open  

 

 

 

 

from now on if you order an 

upgrade or new version, it 

will be delivered on USB 

unless the delivery is digital 

You must install the latest version of 

Compustam on the same PC laptop where your 

current (older) Compustam version is 

 

If you have purchased a new PC laptop with 

Windows 10 to replace, for example, your old 

Windows 7 PC laptop, you must first install the 

latest Compustam version on your old PC 

laptop, otherwise the import will not work 
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Installation Compustam on a pc or laptop without CD-DVD player with 
USB-Stick 

 
 

Compustam installation-cd  Compustam installation USB-stick 

 
 
5 click organize then select all  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6. click then organize copy  
7 go to the USB Stick to (works the same as the Compustam installation CD-USB-Stick)  
8 right-click and choose Paste  
9 Right-click on setup.exe, and then click Run as administrator  

10 Now the installation menu appears and can Compustam be installed  
 

 

 

 

 

 

  

 

  

  

  

 

 

Important: Make sure your login to Windows 8.1 T/M Windows 10 with administrator 

rights than you have permission to remove or install Windows programs 

from now on if you order an 

upgrade or new version, it will 

be delivered on USB 

unless the delivery is digital 
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Load registration file 
 
Loads the registration file from a registration disk. or enter the registration numbers manually  
the registration code is on the registration form you received 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

if you order a wwn upgrade from the 2020 season, it will be delivered on a USB stick 

unless it is delivered (order) is digital) 

 

Note: You cannot register another Compustam version. Compustam is then  

blocked 

Registration ID  Your ID 

name Exactly the 

name on the 

registration 

form (note 

upper and 

lower case 

letters and 

spaces) 

Registration 

key 

You enter 

exactly the key 

that is 

mentioned on 

the form (also 

fill in the 

zeroes) 

New   

Clientnummer Do not forget 

your Customer 

number 

Customer 

number has 

been added 

since 

Compustam 

2017 
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Manual  
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Date settings Windows 8.1 
 

And then well to take the years 1990 2000 + years should you be in the configuration of 

Windows 8 change the following setting once 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Type “Control “and press enter following screen appears 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

click on clock language and Region following screen appears 

 

 

 

 

 

 

 

Skip Windows 8.1 Metro interface  

In Windows 8.1 you can directly go to 
the desktop like in Windows Vista and 
Windows 7  
Right-click any ware on the taskbar 

and choose Properties 

 

 
 

Click the tab navigation and click 

under the heading Home screen. 

Now the Metro interface on 

Windows 8.1 will be beaten Do not 

forget to click Apply 
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Date settings Windows 8.1 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click on Region following screen appears 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Important: Make sure your login to Windows 8.1 T/M Windows 10 with 

administrator rights than you have permission to remove or install Windows 

programs 

Note the short 

time 

designation is 

set correctly dd-

MM-yyyy 
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Date settings Windows 10 
 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

Click the Search button (see arrow with number 1) type in "Control Panel" on the top 

configuration I Tip: Do you want to search from the toolbar, right-click anywhere on the taskbar 

go to look for and then display box 

Click on Clock Language End Region 
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Date settings Windows 10 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click on Region 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note the short 

time 

designation is 

set correctly dd-

MM-yyyy 
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Update Windows version 3 
 
Users of Compustam version 3 can copy the date from the elder version by Import elder 
versions. 
 
 
 
 
 
 
 
 
 
 
Copy the data from Compustam version 3 by selecting your version 3 map (standard name is 
Winstam3) and press "Start conversion" 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Backup  
 
on each PC contains files that 
should not be lost. Therefore, 
create a security Compustam 2020 
files regularly  
It is therefore important to have a 
backup that is not on the computer. 
Also, not on a second partition of 
second hard drive in as save  
Always make 2 backups  
On 2 different sub sticks at import 
from old version  
Also, if you have your data from an 

older version of import to the latest 

version (the version from which you 

are importing data) 

Create security on a USB stick  

Insert the USB stick and wait until it is visible. Follow the instruction data security. Note: 

Looking at the bottom bar on your USB stick, you can now create a security or set back 

Some general indications of not experienced Windows users  
the <Enter> and the <esc> key in most Windows the same function as clicking the mouse on  
the << OK >> or << Cancel >> button respectively to order the next field to go into a window 

you can use the << Tab >> key while with << >> Shift-Tab back to the previous field. Also 

with the mouse you can go to another field by touching it. You can close a window by the 

cross << X >> top right-clicking, or by using the <<Alt >> <<F4 >> key or the 'close button in 

the window if present 
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Update Windows version 4 
 
Users of Compustam version 4 can copy the date from the elder version by Import elder 
versions. 
 
 
 
 
 
 
 
 
 
 
 
Copy the data from Compustam version 4 by selecting your version 4 map (standard name is 
Winstam4) and press "Start conversion" 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Backup  
 
on each PC contains files that 
should not be lost. Therefore, 
create a security Compustam 2020 
files regularly  
It is therefore important to have a 
backup that is not on the computer. 
Also, not on a second partition of 
second hard drive in as save  
Always make 2 backups  
On 2 different sub sticks at import 
from old version  
Also, if you have your data from an 

older version of import to the latest 

version (the version from which 

you are importing data) 

Create security on a USB stick  

Insert the USB stick and wait until it is visible. Follow the instruction data security. Note: 

Looking at the bottom bar on your USB stick, you can now create a security or set back 

Some general indications of not experienced Windows users  
the <Enter> and the <esc> key in most Windows the same function as clicking the mouse on  
the << OK >> or << Cancel >> button respectively to order the next field to go into a window 

you can use the << Tab >> key while with << >> Shift-Tab back to the previous field. Also 

with the mouse you can go to another field by touching it. You can close a window by the 

cross << X >> top right-clicking, or by using the <<Alt >> <<F4 >> key or the 'close button in 

the window if present 
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Update Windows version 5 
 
Users of Compustam version 5 can copy the date from the elder version by Import elder 
versions. 
 
 
 
 
 
 
 
 
 
 
 
Copy the data from Compustam version 5 by selecting your version 5 map (standard name is 
Winstam5) and press "Start conversion" 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Backup  
 
on each PC contains files that 
should not be lost. Therefore, 
create a security Compustam 2020 
files regularly  
It is therefore important to have a 
backup that is not on the 
computer. Also, not on a second 
partition of second hard drive in as 
save  
Always make 2 backups  
On 2 different usb sticks At import 
from old version  
Also, if you have your data from an 

older version of import to the latest 

version (the version from which 

you are importing data) 

Create security on a USB stick  

Insert the USB stick and wait until it is visible. Follow the instruction data security. Note: 

Looking at the bottom bar on your USB stick, you can now create a security or set back 

Some general indications of not experienced Windows users  
the <Enter> and the <esc> key in most Windows the same function as clicking the mouse on  
the << OK >> or << Cancel >> button respectively to order the next field to go into a window 

you can use the << Tab >> key while with << >> Shift-Tab back to the previous field. Also 

with the mouse you can go to another field by touching it. You can close a window by the 

cross << X >> top right-clicking, or by using the <<Alt >> <<F4 >> key or the 'close button in 

the window if present 

https://d.docs.live.net/dfc9395f5024b9f4/Compustam%202017%20HTTPS%20Disclamer/handleiding%20compustam%202017%20engels/https/www.compuclub.nl/


                                                                                                        Manual Compustam  Engels  

© 2018 – 2020 Compuclub - www.compuclub.nl- This PDF file is the manual 
Compustam Engels - On our website the latest version 

32 

 

Update Windows version 6 
 
Users of Compustam version 6 can copy the date from the elder version by Import elder 
versions. 
 
 
 
 
 
 
 
 
 
 
 
Copy the data from Compustam version 6 by selecting your version 6 map (standard name is 
Winstam6) and press "Start conversion" 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Backup  
 
on each PC contains files that 
should not be lost. Therefore, 
create a security Compustam 2020 
files regularly  
It is therefore important to have a 
backup that is not on the computer. 
Also, not on a second partition of 
second hard drive in as save  
Always make 2 backups  
On 2 different usb sticks At import 
from old version  
Also, if you have your data from an 

older version of import to the latest 

version (the version from which you 

are importing data) 

Create security on a USB stick  

Insert the USB stick and wait until it is visible. Follow the instruction data security. Note: 

Looking at the bottom bar on your USB stick, you can now create a security or set back 

Some general indications of not experienced Windows users  
the <Enter> and the <esc> key in most Windows the same function as clicking the mouse on  
the << OK >> or << Cancel >> button respectively to order the next field to go into a window 

you can use the << Tab >> key while with << >> Shift-Tab back to the previous field. Also 

with the mouse you can go to another field by touching it. You can close a window by the 

cross << X >> top right-clicking, or by using the <<Alt >> <<F4 >> key or the 'close button in 

the window if present 

https://d.docs.live.net/dfc9395f5024b9f4/Compustam%202017%20HTTPS%20Disclamer/handleiding%20compustam%202017%20engels/https/www.compuclub.nl/


                                                                                                        Manual Compustam  Engels  

© 2018 – 2020 Compuclub - www.compuclub.nl- This PDF file is the manual 
Compustam Engels - On our website the latest version 

33 

 

Update Windows version 7 
 
Users of Compustam version 7 can copy the date from the elder version by Import elder 
versions. 
 
 
 
 
 
 
 
 
 
 
 
Copy the data from Compustam version 7 by selecting your version 7 map (standard name is 
Winstam6) and press "Start conversion" 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Backup  
 
on each PC contains files that 
should not be lost. Therefore, 
create a security Compustam 2020 
files regularly  
It is therefore important to have a 
backup that is not on the computer. 
Also, not on a second partition of 
second hard drive in as save  
Always make 2 backups  
On 2 different usb sticks At import 
from old version  
Also, if you have your data from an 

older version of import to the latest 

version (the version from which 

you are importing data) 

Create security on a USB stick  

Insert the USB stick and wait until it is visible. Follow the instruction data security. Note: 

Looking at the bottom bar on your USB stick, you can now create a security or set back 

Some general indications of not experienced Windows users  
the <Enter> and the <esc> key in most Windows the same function as clicking the mouse on  
the << OK >> or << Cancel >> button respectively to order the next field to go into a window 

you can use the << Tab >> key while with << >> Shift-Tab back to the previous field. Also 

with the mouse you can go to another field by touching it. You can close a window by the 

cross << X >> top right-clicking, or by using the <<Alt >> <<F4 >> key or the 'close button in 

the window if present 
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Update  Windows version 8 
 
Users of Compustam version 8 can copy the date from the elder version by Import elder 
versions. 
 
 
 
 
 
 
 
 
 
 
 
Copy the data from Compustam version 8 by selecting your version 8 map (standard name is 
Winstam6) and press "Start conversion" 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Backup  
 
on each PC contains files that 
should not be lost. Therefore, 
create a security Compustam 2020 
files regularly  
It is therefore important to have a 
backup that is not on the computer. 
Also, not on a second partition of 
second hard drive in as save  
Always make 2 backups  
On 2 different usb sticks At import 
from old version  
Also if you have your data from an 

older version of import to the latest 

version (the version from which you 

are importing data) 

Create security on a USB stick  

Insert the USB stick and wait until it is visible. Follow the instruction data security. Note: 

Looking at the bottom bar on your USB stick, you can now create a security or set back 

Some general indications of not experienced Windows users  
the <Enter> and the <esc> key in most Windows the same function as clicking the mouse on  
the << OK >> or << Cancel >> button respectively to order the next field to go into a window 

you can use the << Tab >> key while with << >> Shift-Tab back to the previous field. Also 

with the mouse you can go to another field by touching it. You can close a window by the 

cross << X >> top right-clicking, or by using the <<Alt >> <<F4 >> key or the 'close button in 

the window if present 
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Control Panel Compustam voor Windows  
 

 

 

 

 

 

 

The Control panel contains the following items. With the shortcut with pictures 

 

 File – Pigeons- Results-Breed- Extra-Settings- Help 

 

 

Menu-Item File 
 

In the File menu –Item has the following things 

 

Backup data 

Exchange data 

Index files 

Import Elder versions 

Load registration file 

Close 

 

 

Master index 

File 

Pigeons 

Results 

Breed 

Extra 

Settings 

Help 

FAQ 

 

 

 

 

 

 

 

 

 

 

 

new in Compustam 2020 Security to my Compustam Cloud and restore from Cloud 

This part works with a new part my Compustam-Cloud in Compustam-Cloud 

You must install the latest version of 

Compustam on the same PC laptop where your 

current (older) Compustam version is 

 

If you have purchased a new PC laptop with 

Windows 10 to replace, for example, your old 

Windows 7 PC laptop, you must first install the 

latest Compustam version on your old PC 

laptop, otherwise the import will not work 
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Backup data 
 

 

 

 

 

 

 

 

 

Backup data 

 

 

 

 

 

 

 

 

 

 

 

 

 

Restore data 

 

 

 

 

 

 

 

 

 

 

 

 

 

Create security on a USB stick  

Insert the USB stick and wait until it is visible. Follow the instruction data security. Note: 

Looking at the bottom bar on your USB stick, you can now create a security or set back 

Backup  
 
on each PC contains files that should 
not be lost. Therefore, create a security 
Compustam 2020 files regularly  
It is therefore important to have a 
backup that is not on the computer. 
Also, not on a second partition of 
second hard drive in as save  
Always make 2 backups  
On 2 different usb sticks At import from 
old version  
Also, if you have your data from an 

older version of import to the latest 

version (the version from which you 

are importing data) 
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Restore Auto backup 
 

 

 

 

 

 

 

 

 

 

 

 

choose the date and click Start restoring, after a few moments 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tip: create a security on a 

CD or other USB-Stick 2nd 

Hard drives / disks can also 

crash!!! 
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Backup to Compustam-Cloud                                           New in 2020 

 

New from Compustam 9.25 higher (Season 2020) Security to Compustam Cloud 

Replacement of Online Back-ups Microsoft Outlook was required for this 

Important: Check if you have upgraded to Compustam 2020 (version 9.25 higher) 

first under menu item settings tab Cloud all settings 

 

 

To create a Security to Compustam Cloud, go to the File menu item 

Security data Security to Compustam Cloud 

 

1 click on start protection 

A few moments later, the Cloud backup complete message appears 
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Restore from Cloud                                          New in 2020 

 

New from Compustam 9.26 higher (Season 2020) restore Cloud security 

Replacement of Online Back-ups Microsoft Outlook was required for this 

Important: Check if you have upgraded to Compustam 2020 (version 9.25 higher) 

first under menu item settings tab Cloud all settings 

 

 

To create a Security to Compustam Cloud, go to the File menu item 

Security data Reset Security Cloud 

1 Select the correct date 

2 Reset Cloud security 
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Exchange data 
 

 

Export Pigeon data  Import Pigeon data 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Create security on a USB stick  

Insert the USB stick and wait until it is visible. Follow the instruction data security. Note: 

Looking at the bottom bar on your USB stick, you can now create a security or set back 
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Index Files 
 
Note: before importing the old version, it is wise to check the files in this 
          version first indexing via menu item File indexing files 
 
 
 
With this feature you can repair the files again after power failure or other emergency power 
should fail after this option please contact click the Start button to start indexing  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If all is well, the following message appears on the display screen. Click OK to return 
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Update Windows version 3 
 

Users of Compustam version 3 can copy the date from the elder version by Import elder 

versions. 

 

 

 

 

 

 

 

 

 

 

 

Copy the data from Compustam version 3 by selecting your version 3 map (standard name is 

Winstam3) and press "Start conversion" 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Backup  
 
on each PC contains files that 
should not be lost. Therefore, 
create a security Compustam 2020 
files regularly  
It is therefore important to have a 
backup that is not on the computer. 
Also, not on a second partition of 
second hard drive in as save  
Always make 2 backups  
On 2 different usb sticks at import 
from old version  
Also, if you have your data from an 

older version of import to the latest 

version (the version from which you 

are importing data) 

Create security on a USB stick  

Insert the USB stick and wait until it is visible. Follow the instruction data security. Note: 

Looking at the bottom bar on your USB stick, you can now create a security or set back 

Some general indications of not experienced Windows users  
the <Enter> and the <esc> key in most Windows the same function as clicking the mouse on  
the << OK >> or << Cancel >> button respectively to order the next field to go into a window 

you can use the << Tab >> key while with << >> Shift-Tab back to the previous field. Also 

with the mouse you can go to another field by touching it. You can close a window by the 

cross << X >> top right-clicking, or by using the <<Alt >> <<F4 >> key or the 'close button in 

the window if present 
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Update Windows version 4 
 

Users of Compustam version 4 can copy the date from the elder version by Import elder 

versions. 

 

 

 

 

 

 

 

 

 

 

 

Copy the data from Compustam version 4 by selecting your version 4 map (standard name is 

Winstam4) and press "Start conversion" 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Backup  
 
on each PC contains files that 
should not be lost. Therefore, create 
a security Compustam 2020  files 
regularly  
It is therefore important to have a 
backup that is not on the computer. 
Also, not on a second partition of 
second hard drive in as save  
Always make 2 backups  
On 2 different usb sticks At import 
from old version  
Also, if you have your data from an 

older version of import to the latest 

version (the version from which you 

are importing data) 

Create security on a USB stick  

Insert the USB stick and wait until it is visible. Follow the instruction data security. Note: 

Looking at the bottom bar on your USB stick, you can now create a security or set back 

Some general indications of not experienced Windows users  
the <Enter> and the <esc> key in most Windows the same function as clicking the mouse on  
the << OK >> or << Cancel >> button respectively to order the next field to go into a window 

you can use the << Tab >> key while with << >> Shift-Tab back to the previous field. Also 

with the mouse you can go to another field by touching it. You can close a window by the 

cross << X >> top right-clicking, or by using the <<Alt >> <<F4 >> key or the 'close button in 

the window if present 
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Update Windows version 5 
 
Users of Compustam version 5 can copy the date from the elder version by Import elder 
versions. 
 
 
 
 
 
 
 
 
 
 
 
Copy the data from Compustam version 5 by selecting your version 5 map (standard name is 
Winstam5) and press "Start conversion" 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Backup  
 
on each PC contains files that 
should not be lost. Therefore, 
create a security Compustam 2020 
files regularly  
It is therefore important to have a 
backup that is not on the computer. 
Also, not on a second partition of 
second hard drive in as save  
Always make 2 backups  
On 2 different usb sticks At import 
from old version  
Also, if you have your data from an 

older version of import to the latest 

version (the version from which 

you are importing data) 

Create security on a USB stick  

Insert the USB stick and wait until it is visible. Follow the instruction data security. Note: 

Looking at the bottom bar on your USB stick, you can now create a security or set back 

Some general indications of not experienced Windows users  
the <Enter> and the <esc> key in most Windows the same function as clicking the mouse on  
the << OK >> or << Cancel >> button respectively to order the next field to go into a window 

you can use the << Tab >> key while with << >> Shift-Tab back to the previous field. Also 

with the mouse you can go to another field by touching it. You can close a window by the 

cross << X >> top right-clicking, or by using the <<Alt >> <<F4 >> key or the 'close button in 

the window if present 
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Update   Windows version 6 
 
Users of Compustam version 6 can copy the date from the elder version by Import elder 
versions. 
 
 
 
 
 
 
 
 
 
 
 
Copy the data from Compustam version 6 by selecting your version 6 map (standard name is 
Winstam6) and press "Start conversion" 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Backup  
 
on each PC contains files that 
should not be lost. Therefore, 
create a security Compustam 2020 
files regularly  
It is therefore important to have a 
backup that is not on the computer. 
Also, not on a second partition of 
second hard drive in as save  
Always make 2 backups  
On 2 different usb sticks At import 
from old version  
Also, if you have your data from an 

older version of import to the latest 

version (the version from which 

you are importing data) 

Create security on a USB stick  

Insert the USB stick and wait until it is visible. Follow the instruction data security. Note: 

Looking at the bottom bar on your USB stick, you can now create a security or set back 

Some general indications of not experienced Windows users  
the <Enter> and the <esc> key in most Windows the same function as clicking the mouse on  
the << OK >> or << Cancel >> button respectively to order the next field to go into a window 

you can use the << Tab >> key while with << >> Shift-Tab back to the previous field. Also 

with the mouse you can go to another field by touching it. You can close a window by the 

cross << X >> top right-clicking, or by using the <<Alt >> <<F4 >> key or the 'close button in 

the window if present 
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Update   Windows version 7 
 
Users of Compustam version 7 can copy the date from the elder version by Import elder 
versions. 
 
 
 
 
 
 
 
 
 
 
 
Copy the data from Compustam version 7 by selecting your version 7 map (standard name is 
Winstam6) and press "Start conversion" 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Backup  
 
on each PC contains files that 
should not be lost. Therefore, 
create a security Compustam 2020 
files regularly  
It is therefore important to have a 
backup that is not on the computer. 
Also, not on a second partition of 
second hard drive in as save  
Always make 2 backups  
On 2 different usb sticks At import 
from old version  
Also, if you have your data from an 

older version of import to the latest 

version (the version from which you 

are importing data) 

Create security on a USB stick  

Insert the USB stick and wait until it is visible. Follow the instruction data security. Note: 

Looking at the bottom bar on your USB stick, you can now create a security or set back 

Some general indications of not experienced Windows users  
the <Enter> and the <esc> key in most Windows the same function as clicking the mouse on  
the << OK >> or << Cancel >> button respectively to order the next field to go into a window 

you can use the << Tab >> key while with << >> Shift-Tab back to the previous field. Also 

with the mouse you can go to another field by touching it. You can close a window by the 

cross << X >> top right-clicking, or by using the <<Alt >> <<F4 >> key or the 'close button in 

the window if present 
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Update Windows version 8 
 
Users of Compustam version 8 can copy the date from the elder version by Import elder 
versions. 
 
 
 
 
 
 
 
 
 
 
 
Copy the data from Compustam version 8 by selecting your version 8 map (standard name is 
Winstam6) and press "Start conversion" 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Backup  
 
on each PC contains files that 
should not be lost. Therefore, 
create a security Compustam 2020 
files regularly  
It is therefore important to have a 
backup that is not on the computer. 
Also, not on a second partition of 
second hard drive in as save  
Always make 2 backups  
On 2 different usb sticks At import 
from old version  
Also, if you have your data from an 

older version of import to the latest 

version (the version from which you 

are importing data) 

Create security on a USB stick  

Insert the USB stick and wait until it is visible. Follow the instruction data security. Note: 

Looking at the bottom bar on your USB stick, you can now create a security or set back 

Some general indications of not experienced Windows users  
the <Enter> and the <esc> key in most Windows the same function as clicking the mouse on  
the << OK >> or << Cancel >> button respectively to order the next field to go into a window 

you can use the << Tab >> key while with << >> Shift-Tab back to the previous field. Also 

with the mouse you can go to another field by touching it. You can close a window by the 

cross << X >> top right-clicking, or by using the <<Alt >> <<F4 >> key or the 'close button in 

the window if present 
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Load registration file 
 
Loads the registration file from a registration disk. or enter the registration numbers manually  
the registration code is on the registration form you received 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Close 
 

With this option you can close Compustam 2020 

 

Note: You cannot register another Compustam version. Compustam is 

then  

blocked 

Registration ID  Your ID 

name Exactly the 

name on the 

registration 

form (note 

upper and 

lower case 

letters and 

spaces) 

Registration 

key 

You enter 

exactly the key 

that is 

mentioned on 

the form (also 

fill in the 

zeroes) 

New   

Clientnummer Do not forget 

your Customer 

number 

Customer 

number has 

been added 

since 

Compustam 

2018 
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Menu-Item Pigeons 
 

Pigeon Data  

Pigeon Data Add & edit 

Pigeon Data  Pedigree 

Pigeon Data Printment 

Pigeon Data Search ring With binoculars 

Pigeon Data Serrch in text 

Print series of pedigrees  

list of pigeoncode  

Add/delete Pigeoncodes  

List purchases/sales  

List per loft  

pigeon to other loft  

 

 

 

 

 

 

 

 

Master index 

File 

Pigeons 

Results 

Breed 

Extra 

Settings 

Help 

FAQ 
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Pigeondata 
 
In this window you can add, remove or edit pigeons, add notes, show and print pedigrees etc 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
New in version 8 
Compustam 
 
 
 

Pigeondata 
 
In this window you can enter all the data, edit pertaining to feed the dove in, you can quickly call 
a pedigree performance offspring retrieve search request notes (notes if any) via buttons with 
yellow arrows. 
 

Using the buttons at the top of the screen you can perform the operations 
add Add a new pigeon to pigeon’s data  
delete Delete a pigeon from pigeon data 

Edit  Edit pigeon data 

Find  Find Pigeon data 

Copy Copy Pigeon data 

Notion Leaf Leaf notion 

Pedigree Pedigree from pigeon 

  

 
 

New in Compustam 2018 

Pigeon screen 

-Pedigree 3 generations and 4 extra generations are the fields 

of the first 2 generations enlarged with 6 additional rules 

-When introducing new pigeons, country code is automatically 

filled with the standard country code 

-In Screen Pigeons selection possibility in loft 
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Pigeondata 
 
 
                                          
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If you are about to add / edit the dove is divide into three tabs 
 
 
 
 
 
 
 
 
 
Tab Basic data 
Tab Purchase/sale 
Tab Diary 
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Pigeondata Add & edit 
 

You can set colors per pigeon for example, a certain bloodline or race etc. If you press the 

button, you can add or edit, click the Add tab basic data or change. For color settings box, you 

click back color ring number or color box, you will see which can be selected. Schedule with  

the red minus button to remove the color. You can easily add a dove through pedigree. If you 

have entered a dove with parents you see 

on the tree green box with the ring 

number, click on the green box to the 

father / mother to add to your family tree 

file. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

TIP: By clicking on the white box you can enter the youngster's parents can best work 

this way. Look Through the binoculars the pigeons. If you type the pigeons immediately goes 
wrong and there is no good pedigree shown. If you look up the birds with binoculars the 
clutch properly made and the country codes easily viewed directly to use for your  
ES-System 
New in Compustam 2018 default country code  
 
Remember if you make a family tree can also be used. Proper country codes If the country 
codes entered once good and you make one or more pigeons loft list, they're even good 
 
 

It is best to first add the ring series of the youngsters and then the parents  
present search with binoculars 
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Pigeondata Add & edit 
 

  
afterwards you will see the following 
screen 
 

 
 

Some important clues 
 
- The year must always be filled with 4 digits  
- Change input field by means The Tab key (one 
square) or SHIFT + TAB (backwards one field)  
     the mouse is also possible. 
 
- Compustam is set so that there are two sizes 
of ring numbers can enter. 
 
- To enter the Dutch format, Turn on the first 
field 
 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

Example. with ring number 20-1234567 fill in: 1st 2nd box empty box 2020 and the 3rd box 

1234567 Eg. German ring number 15412-18-34567: 1st 2nd box 15412 box 2020 and the 3rd 

Box 34567 

 

To change a pigeon (bottom left of the window), the parents can use the search button 
with the binoculars. Then you can easily adjust the father or mother search your pigeons. 
The parent is not there, you can also enter the ring number. Note: the last method will only 
ring number in the family tree 
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Pigeondata Add & edit 

 

New from Compustam 2018: set default country code 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 

TIP: It is best to work this way. Through the 

binoculars to look up the pigeons. If you type the 
pigeons immediately goes wrong and no good 
pedigree shown. If you are using the binoculars 
the pigeons look up the link is made and 
the country codes easily viewed directly to use for 
your ES – System 
New in Compustam 2017 default country code                                                  

Remember if you make a family tree can also be used. Proper country codes If the 
country codes entered once good and you make one or more pigeons loft list, they 're 
even good. 
 
See the following sections for more information 
Change Country Codes and Country Codes 

 

 

Important note: If you are after adding a pigeon discovered that the ring number are 

inserted incorrectly, you cannot change the ring number. The whole number of the ring 

dove You must delete and re-ring the correct number to add 
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Pigeondata   Pedigree  
 

 

.  

If you click the button you will receive a pedigree pedigree Scrolls 5 generation. You can  

do the following things with this screen. 

 

  

Printmenu Go to printmenu  

To sie If you click on this option you go to the sie site 

Naar moeder  If you click on this option you go to the Dam site 

Back If you click on back you return to thee youngstar  

On Ringnumber You have access to Pigeon data from the pigeon 
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Pigeondata Printmenu  
 

 

 

 

 

 

 

General tab:  

In this menu you can give family on the basis of some institutions a nice layout. The settings are  

- Number of generations size photos printing format (Half A4)  

- Options observations and / or performance printing on the tree (click on white box)  

    You can also specify whether the notes of all the birds on the tree are to be printed  

- Photos click on the arrow next to text window "picture of pigeon 'to select something else. You 

can also set a default  

    photo award  

- Page Setup: You can apply up to a range of 10 cm above and left.  

* Note, however, that the entire family shifts that may no longer fit on paper)  

You can enter up to 90% - 110% of the subjects of the pedigree in width and height adjustment 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 At the bottom of the Dove Data 
Screen You will find these 
buttons, and the pedigree and 
then print menu appears  
menu where you will find the 
master card options can set 
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Pigeondata Printmenu  
 

 

 

 

 

 

 

TAB: Color Settings   

If you click on the tab color settings you can select the colors that you want on the family tree  

assigning You can specify which color box you want to use, you can also specify whether to 

shade the boxes want. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

click for example the color next ring number to change the color. You can also choose other 

colors' button to make a  

color to your taste add. You can also be using the mouse in the field colors on the color button. 

Use the slider to the right of the color field to the color harder or softer.  

Click on the Add color to the selected color to add to your color collection 

 

New in Compustam 2018 

Print options 

-Stam cards with pigeon photo in each pigeon box 

- For font card, the font style is adjustable for ring number, pigeon name, breed, and breeder 

-Two free fields on the card for eg e-mail address and website 

-View gender code in the enrollment list 

- In breed cards pigeon name, breed and breeder can be printed in a different color 

 At the bottom of the Dove Data 
Screen You will find these 
buttons, and the pedigree and 
then print menu appears  
menu where you will find the 
master card options can set 
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Pigeondata Printmenu  
 

 

 

 

 

 

 

 

The final result you can get on the first screen to determine whether the family is suitable  

in order to print. Through the sliders to move the bottom and right to scroll through the tree back  

slide. Also, you can put the mouse on the tree with the left and right, hold and move the mouse 

o, move over your screen. Trunk card 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you click on the button notes can all notes proforma seeing the pigeons a notepad to the  

selected pedigree. If you have checked this option, they will be printed after the printing of the 

master card. 

New in Compustam 2018 

Print options 

-Stam cards with pigeon photo in each pigeon box 

- For font card, the font style is adjustable for ring number, pigeon name, breed, and breeder 

-Two free fields on the card for eg e-mail address and website 

-View gender code in the enrollment list 

- In breed cards pigeon name, breed and breeder can be printed in a different color 

 At the bottom of the Dove Data 
Screen You will find these 
buttons, and the pedigree and 
then print menu appears  
menu where you will find the 
master card options can set 
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Pigeondata Printmenu  
 

 

 

 

 

 

 

 

 

Tab "Header"  

You can decide what header is used for such a language other than Dutch 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 At the bottom of the Dove Data 
Screen You will find these  
buttons, and the pedigree and 
then print menu appears menu 
where you will find the master 
card options can set 
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Pigeon Data Search ring with binoculars 
 

 

 
 
 
 
 
 
 
 
 
 

TIP: It is best to work this way   

Through the binoculars the pigeons look. If you 
type the pigeons go directly wrong and no good 
pedigree shown If you look through the 
binoculars pigeons, the link is made and  the 
country codes directly properly to  
Your use ES-System 
New in Compustam 2017 default country 
code                                                                                                                                                                                                                                                                                      

 Think of it as a family also makes good to use 
country codes If the country codes Once 
entered properly and you make a or more 
pigeons loft list then they are equal properly. 
 
  See the following sections for more information 
Country codes and Dove Codes 
 

 

Through the binocular you can look it up in your pigeon pigeons. You do this by the last three 

digits  

typing. of the ring number  

 

TIP: If you enter the last 3 digits but the bird is still not to set the search function on:  

- From 1900  

- All sex  

- Selection code dove off (unchecked)  

- Start selection  

 

Then select the correct dove right as Compustam several pigeons find and click OK 
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Pigeondata Search in tekst  
 
You can now search all fields at once a pigeon on a specific text. 
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Print series of pedigrees 
 

More pedigrees to print, select your own series 

 

 
 

You are looking through the binoculars to the ring number where to print from. You In this case, 

the ring number 2020-1368814 t / m 2020-1368826 You can also make a selection dove code. 

Then only the trunk cards printed with the dove code you specify. 

Print series of pedigrees 
 

When you click the Print, button click takes you to the screen pedigree options correctly. Here 

you can define the layout of the strain maps. If you select 'print' click the button you will see that 

state how much trunk cards you want to print a screen. 
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List on pigeoncode 
 
Enter one or more pigeon codes for selecting pigeons. Notice the difference between and/or.  
For instance, when you make a selection on the codes "A" and "B" the "and" option will result in 
a list with pigeons with both the code "A" and "B" while the "or" option will result in a list with 
pigeons with at least one of the codes "A" or "B". 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
List layout  
You can change the layout of the list by clicking on List layout.  
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Add/delete pigeoncodes 
 
If you want to change, add or delete pigeon codes of a large number of pigeons you can make a 
selection of pigeons first. Press "Start selection" to select the pigeons.  
In the right part of the screen you can edit the pigeon codes in the columns with header "P". 
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replace country code                                                     new from version 9.24 

 

This is a new option in Compustam and can be used to change incorrect country codes at once. 

The country codes are used on your loft list.udp and also your ES-system uses the country 

codes. New: now also without changing a country code, change to the specified country code. 

Also immediately enter a Country code 

 

 

List purchares/sales 
 

You can make a list of alle sold/purchased pigeons 
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List per loft 
 
With this option you can see the pigeons per loft you can enter loft number of the loft and press select  

you can enter loft numbers in menu item Pigeons>pigeon data and press add or edit 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tip: If you remove pigeons and more pigeons than you will actually be able to hoknummer 

probably indicated. By selecting the stuffy and clicking pigeon data, you can delete the 

hoknummering. 
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Pigeons to other loft 
 

With this option you can move all pigeons form one to the other loft 
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Menu-Item Results 
 

 

Edit race  

Edit results  

Delete results Delete results for a pigeon 

Delete results Delete results for a race 

Delete results Remove a results on date 

Browse per race  

Browse per pigeon  

Find best pigeon  

Annual Survey  

 

 

 

 

                             

                              

 

 

 

 

 

 

Master index 

File 

Pigeons 

Results 

Breed 

Extra 

Settings 

Help 

FAQ 
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Edit race 
 

In this menu, you can enter flight. The unloading point can be selected by clicking the down 

arrow button. The losplaatsentabel you can update the menu item: Tools. In the same way, you 

can select the direction. This table cannot be edited. Enter the date in the field, in full, eg 15-04-

2019. The bars are filled in automatically. You can rename a flight by flight rename the button to 

click 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

you will see a screen current flight code is displayed. You can then enter a new flight code. 

Then click OK to rename the new flight code. Flight code 
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Edit results 
 

In this section you can maintain the performance of the pigeons. You can either browse the 

known keys or enter to view the performance. Directly to the flight date In the date field full date 

eg 01-04-2017. The bars are filled in automatically. 

 

 

 

 

With the arrow-buttons you can browse through the races. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Race Sheet: if all the pigeons are placed on the race you can print your race-sheet 

 

 

 

 

 

 

 

 

 

 

 

 

In Compustam for Windows version 7 1 pigeon putted on the same day, several flight 

codes. It should be thought that such fondclub rerouting code is drilling the same flight. 
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Delete results – Delete results for a pigeon 
 

Enter a pigeon's ring number and press "OK" to delete all the results of the pigeon. Use the find 

button to look for a pigeon in the pigeon file 

 

 

 

 

 

 

 

 

 

 

 

Delete results – Delete results of a race 
 
With this option you can remove a race and all the results of the race.  
Enter the race date and the race code or search for the race with the Find-button and press OK. 

 

 

 

 

 

 

 

 

 

 

 

Delete results – Remove a result on date  
 
With this option you can remove a race and all the results of the race.  
Enter the race date and the race code or search for the race with the Find-button and press OK 
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Brouse (Results) per race 
 

In the upper window you can browse through the races. The lower window shows the results of 

the selected race. With the tabs you can select a level. The results can be sorted in ring or 

placing order 
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Brouse (Results) per pigeon 
 
In the upper window you can select a pigeon. The lower window shows the results of the 
selected pigeon. With the tabs you can select a level.  
Pressing the "Best results" button will show only the best results of the pigeon, taking into 

account the "Selection criteria best results" in Settings, User settings, Results. 
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Find best pigeon 
 

Enter the selection criteria to select the best pigeons. By pressing the button "Extensive" you 

get more criteria to select on. 
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Annual Servey 
 
With annual reviews, you can select flights and thus have an overview on price points or 
possibly a couple. If you have annual reviews startup you will see in the left column are the 
flights you entered. At the top, you can change the year, you choose one or more flights by 
double-clicking with the mouse or by using * or letter then click on or off.  
 
In the right column, you can select the level you want to see an overview. If you want to have a 
selective overview, you can also select dove code. If you have entered the data, you can click 
the Select button. Compustam now calculates based on your settings, if you click on the items 
price or list appears with some prizes or points. You can also filter by gender. You can also see 
the parents of the performance pigeons, then you can quickly pick out the good couples.  
 
You can set the font size, the larger the font, the fewer flights to print. With the Print button to 
print the list to a printer in which you may have to file to store the data.  
 
Threre are graphs each pigeon that can be set with color and options from the diary linked. 
There is now the ability to find via a search option in the annual a pigeon. 
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Annual Servey 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

go to menu item Results and choose edit result and click binocular to find a race 
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Top prizes loft 
 

 

 
 

 

 

 

  

 

 

 

 

Tip: if you cannot print from top prizes hutch first 

click once "Select" and then you can still print. 

 

 

 

 

 

Performance top prizes  

- Indication of pigeon ring numbers and parents  

- Mention sex, unloading, wind, some birds competing  

-Graphical display performance - Instant playback 

pedigrees 

https://d.docs.live.net/dfc9395f5024b9f4/Compustam%202017%20HTTPS%20Disclamer/handleiding%20compustam%202017%20engels/https/www.compuclub.nl/


                                                                                                        Manual Compustam  Engels  

© 2018 – 2020 Compuclub - www.compuclub.nl- This PDF file is the manual 
Compustam Engels - On our website the latest version 

78 

 

Menu-Item Breed 
 

Calculate planning date 

Browse pairs/breed 

Edit breed 

Add series of ring numbers 

offspring list 

Pro forma pedigree 

Pair list 

List youngsters per round  

Nest box cards 

List youngsters 

Find youngster in breed database 

Copy breed jr 

 

 

 

Master index 

File 

Pigeons 

Results 

Breed 

Extra 

Settings 

Help 

FAQ 

 

 

 

 

 

 

 

 

 

 

New in Compustam 2018 

Pair  and breeding 

-List  cultivation per round can be sorted by date Ei-1 

-If importing young pigeon in breeding data already exists, there will be an error message 

  indicated at which torque number, bin number and round number it belongs 

-Function in the 'File' menu and the screen-breeding-screen to update the bucket and loft 

  in pigeon data 

-In case of insertion, the loft and bin number is updated in pigeon file 

-When looking for couples on shortened ring number of father and mother 
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Calculate pairing date 
 

With this option it is possible to calculate the pairing-date 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Brouwse pair/breed 

Suppose you want to do winter breeding  

You get 1 January; the rings of the ring 

Administrator shall want you directly to the 

youngsters can slide the young newly rings around 

7 days. You can leave young 7 days of the date in 

this case 01-01-2020 instantly calculates the 

program from various dates.  

You can see the best couple date is November 25, 

2019 at a driving time of 10 days to do the pigeons 

takes longer than 10 days between the link and the 

1st egg you can naturally increase or decrease the 

number of days.  

 

Advantages:  

You no counting from the date on the calendar itself 

 - If you want to vacation in between you can have a 

    quick way to calculate an ideal couple date  

- so your birds breed during your absence. 

 - You can calculate this way when the boy pacifier 

ready  

- You can nest an ideal position for flights calculate 
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Brouwse pair/breed 
 

By clicking the Add button to add a new flock, when you click the Edit button, double click on the 

couple to work then you can edit / change by pressing the delete button this couple you remove 

the torque is selected. This is indicated by the blue bar with a black triangle there to see 

explanation. Insert you double-click a boy determines torque is directly on the screen 

maintenance culture. 

  

  

  

  

  

 

 

 

 

 

 

 

 

The Pro-forma button, you can also see a pro-forma pedigree also can according to the 

selected codes dove leaves select this couple is the couple acquired to browse & culture data 

by the fathers and mothers and the button 

 

 

 

 

 

 

 

 

 

 

 

 

 

important loft numbering always 

01-01 for a loft one and box one 

and not 1-1 

For new couples input fill loft / bake no in 

for example You have a couple of loft and 2 is in the 3rd breeding book please fill it out as 

follows: 02-03 

with serial number is following means at the 1st link of some cock in a loft determines / 

broedbak get the serial number if one is on the same cock coupled with a new hen will get 

the number 2, the cock once more linked than about getting the serial number 3 ect. 

with binoculars you on that cock or hen look, fill in the date and torque you can fill in the 

breed. 
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Brouwse pair/breed 
 

Every year you have the torque and breeding data re-enter. Behind breeding year, you through  

to go        back and go forward.       In Go, go directly to the correct loft and bake 

 

eg loft 4 speed 4, then 04-04 (see also with new torque input fill loft / bake no in) 

 

The                                   middle buttons scroll forward or backward a couple   
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Edit Breed 
 
In this window you can add the youngsters per round to the pairs.  
Select a pair by entering the breed year and the pair number or by clicking the find button.  
With the tabs you can select a round number, and for every round you can enter the data for the 
two youngsters. With the pigeon data button, you can complete the information about the 
pigeon.  
The youngsters entered in this window will be added to the pigeon file. 
 
The                                  middle buttons scroll forward or backward a couple 
 
If you have changed anything, do not forget                              to click 
 

 

 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

Breed JR  ff     (1) Pair rew                ( 
2) 

Pair forward   ( 3) Breed FR forward ( 
4) 

TIP: You can work best in this way through the binoculars to look up the pigeons. If you 

type the pigeons immediately goes wrong and there is no good pedigree shown. If you look 
through the binoculars birds the clutch properly made and the country codes easily viewed 
directly to use for your ES-System Remember if you make a family tree can also be used. 
Proper country codes If the country codes entered once good and you make one or more 
pigeons loft list, they're even good 
 
See the following sections for more information  
  Change Country Codes 
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Edit Breed 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Enter the information that you know for example, color and race and dove name and, optionally, 
whether it is a cock or hen  
it is important that you complete this information as much as possible, especially if you want to 
Export the dove or pigeon 

If you click on the button 

pigeon data the right screen  

click shortened tab. In the first 

box, the last two digits of the 

year and in the second box  

the last three digits of the 

approval number of your 

choice  

when you are finished, click 

OK  

Is there already a ring number 

than the dove appears 
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Add series of ringnumbers 
 

You can once add ring serial numbers of youngsters to give your pigeons in the year of the 

pigeons and then start the ring number. The first five digits of the starting ring number are 

automatically copied to the end ring number at the end ring number, the last 3 digits should be 

to be fed. You can enter up to 200 birds at one-time larger series should be introduced. As 

several small series  

 

When a series of young birds is introduced in this way, culture can be entered using a 

youngster quick maintenance the search function.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

New!! the option directly enters a pigeoncode when add series of ring numbers to pigeon 

file 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

TIP: This way you can also use it 

as another pigeon fancier breeds 

for you and your ring series used 

this lover put your ring in his series 

Compustam version on a separate 

pigeon code. Then the pigeons are 

bred for that you have saved. 

Using the Export option on pigeon 

code Important If you go over the 

ring series does not enter into your 

own Compustam version to work in 

this way 
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Offspring 
 

To obtain an offspring list of a pigeon, enter the pigeons ring number and the number of 

generations you want to be listed. Press select to start the search operation 
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Pro forma pedigree 
 

 

Enter the ring numbers of a sire and a dam or 
select them by using the find buttons. After 
pressing the pro forma pedigree button the 
program will show a pedigree of 4 
generations. This way you can view the 
pedigrees of virtual pairs in advance to make 
the right match 
 
 
 

 
 
 
 

Use the arrows to scroll forward or backward 
through the cocks and hens 

 
 
 
 
 
 
 

If you click on the button codes dove dove 
codes you can specify that you only want to 
see to scroll eg only the racers or just the 
breeding pigeons or a particular  
variety depending on your pigeon codes. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Using the printing feature to print pro forma 
pedigree 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  Scroll through options to mother 'and' father 
in "you can browse unlimited generations 
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Pair list 
 

You can use this option to enter a list of flocks of a certain year by one year and then press 

select to generate the list using the print option you can print the list. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: when printing, you can set a print preference. Dove name or variety 

 

Youngster per round 
 

By entering the year of cultivation and the round number you can create a list of breeds per red 

using the print option you can print the list. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: when printing, you can indicate a sorting. Best torque nr. Or 1st egg 
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Print Nest box cards 
 

Enter breeding year, start and end pair number to print nest box cards. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

List youngstars 
 
Enter the breeding year of the list to be printed.  
You can select all youngsters or just the cocks or hens.  
You can also make a selection on pigeon codes by checking the check box and choosing one 

or more pigeon codes. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

important loft numbering always 

01-01 for a loft one and box one 

and not 1-1 
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Find youngstar in database 
 
Enter the ring number of a youngster.  
Press the find button. If found the program will give all the breeding information about the 

pigeon. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Copy Breed JR 
 

Whit this you can copy all pairs from breed year to another breed year 
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Menu-Item Extra 
 

Estimate time of arrival 

Velocity Calculator 

Analyse flight 

Diary 

 

 

 

Master index 

File 

Pigeons 

Results 

Breed 

Extra 

Settings 

Help 

FAQ 
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Estimate time of arrival 
 

By entering your distance and the liberated time the program will give the time of arrival by 

possible velocities. 
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Velocity Calculator 
 

By entering your distance and the flight time the program will give the velocity 
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Analyze flight 
 
Enter liberation point (with latitude-code and longitude-code) and enter arrival point (with 
latitude-code and longitude-code).  
The program draws the line, up to 5 arrival points are possible at one time 
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Diary 
 
With daily diary, you can capture the various activities per day per pigeon. You can also plan 
into the future contain activities capture so you will be reminded when you start Compustam.  
The diary looks like 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The diary consists of three parts: 
  
- Date and display  

- The actions that need to be performed  

- The pigeons which the acts entered date is applied  
 
Date and Display:  
 
The bold numbers in the month means that on that day one or more activities, occurred.  
You can click on any day or go to a different month or year. If today you click the button, the 
current date set  
The display can be adjusted by the following set itself  
 
- Period  

- Status  

- Category  
 
If you click on the calendar button week or month calendar gives you an overview in a preview 

screen which you can print. 
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Diary 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The act performed or to be performed are  
If you click the green plus button to add an action.  
If you click the red minus button to remove an action.  
If you select the action (making blue) can give you a status for the operation concerned. 
Completed or outstanding. Closes an action, and this is not in the main  
You can specify a description for action / event.  
The floppy disk button at the top of the screen to save data in Compustam  
 

 

 

 

Menu-item move to 

 
 
 
 
 
 
 
 
 
 
 
 

Menu-item copy to 
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Diary 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The pigeons that entered operation and date applied.  

With the green plus button to add one pigeon.  
With the red minus button to delete one pigeon (which is marked blue)  
Add to the selection button inserts in one fell swoop a whole selection to code or a pigeon loft 
the selection button makes emptying the entire selection empty again  
This has as an example if you look at the graph on pigeon that you can see in the chart  
days on which an event has occurred. Imagine yourself 3 points a pigeon in the same week off  
and you create with dove on a good result then you can immediately see from the chart that the 
buggy a positive contribution to the performance.  
Conversely, of course, too. If substandard is presented may be appropriate that a particular 
event is eg cancer cure  
In the tab 'Diary' is maintenance screen pigeon can you see what the event with the appropriate 

Dove has happened or should happen 
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Diary 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

After introduction event, you can see it immediately on the maim screen so you are warned 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Help! I cannot see diary on the main 

screen? Go to the menu- item settings tab 

Main Window 
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Menu-Item Settings 
 

 

User settings  

User settings Personal settings 

User settings Loft list 

User settings Results data 

User settings Breed 

User settings Main Window 

User settings Fonts 

User settings Cloud 

Address book  

Country codes  

Beeds  

Pigeon codes  

Dairy Categories  

 

 

 

  

   

Master index 

File 

Pigeons 

Results 

Breed 

Extra 

Settings 

Help 

FAQ 
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User settings – Personal settings 
 

Enter your personal data here as soon as you have filled in a field. Use the Tab key to jump to 

the next field with the key combination SHIFT + TAB. 

New in Compustam 2018 the country code you enter here is used as a standard 

Note: enter the coordinates without a decimal point. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

New IN  
Compustam 
2018 
automatic 
the standard 
country code 
when entering 
new pigeon 

NR Country COUNTRYCODE NR COUNTRY COUNTRYCODE 

1 België B 17 Polen RP RP 

2 Bulgarije  BU 18 Portugal P 

3 Denemarken DK 19 Roemenië RE 

4 Duitsland D 20 Schotland SU 

5 Engeland UK 21 Slovenië SV 

6 Frankrijk F 22 Slowakije SL 

default Country 
code  

Set-up 

7 Hongarije HU 23 Spanje ES 

8 Ierland IE 24 Thailand TH 

via menu item 
settings 
user 
data 
Which country 
code U 
the 
standard 
country code 

9 Italië I 25 Tsjechië TJ 

10 Luxenburg L 26 Wales WH 

11 Malta MA 27 Zweden S 

12 Marokko MO 28 Zwitserland CH 

13 Nederland NL 29 USA US 

14 Noorwegen NO 30 China CN 

15 Ostenrijk A 31 Taiwan TW 

16 Polen  PL 32 Onbekend XX 
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Enter your hoklijstgegevens as soon as you have entered a field with the TAB key skips to the 

next field with the key combination SHIFT + TAB moves one pitch back. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

User settings – Loft list  
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User settings – Race results 
 
In the column "Description levels" you can give every level its own name. "Minimum proportion" 
determines what results are to be selected for best results.  
When you choose a proportion of 1:10 (Results percentage = 90) only the pigeons classified in 
the upper 10 per cent of a game will be selected. The program searches through all the levels to 
find the best proportion for a pigeon at every race.  
With "Minimum competitors" you can let the program omit results of games with very few 

competitors. 
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User settings – Breed 
 

Enter the pigeon code you want to use for breeding birds 

 

 

Enter your hoklijstgegevens as soon as you have entered a field with the TAB key skips to the 

next field with the key combination SHIFT + TAB moves one pitch back. 
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User settings – Main Window 
 

Here you can set the diary settings 

 

Here you can set whether you are getting the operations on the main menu screen after booting 

Compustam for Windows also allows you to specify the number of days how long an act must 

be shown. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

check diary display in main screen if you want to see it as Compustam start-up  
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User settings – Fonts 
 
Choose normal or big fonts.  
The underline check box holds for all printed lists except for the pedigrees. 
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User settings – Cloud                                                                      new in 2020 
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Address book 
 
This data base contains all purchasers, sellers, breeders.  
If you define a breeder it is possible to select the name in the "edit pigeon-data"-screen for the 

fieldname breeder. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Buttons Adresbook 
Add Add a new address in adresbook 

Delete  Delete a address off the adresbook 

Edit Edit one address in the adresbook 

Find Type a part of text of name in  

Print Print adres list  
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Countrycodes 
 
Enter the country codes you want to use for the pigeon data.  
The country codes from this list will appear in the list box country in the pigeon data screen 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Breeds 
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Pigeoncodes 
 
Enter the the pigeon codes you often use.  
The colours will appear in the colour list box of the pigeon window. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Diary Categories 
 

You can think of categories that you can process in the journal examples of categories 

themselves:  

- of raising  

- Grafting  

- Medication  

- Give a Bad 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Buttons Category 

Add To add a category 

Delete Delete a category  

Edit To edit a catagory 

For here the dove codes 

commonly used in, see for 

example from you can also add an 

equal pigeon code if you add a ring 

array of such youngsters. 

Add series of ringnumbers by 

 

Menu-item Breed add series of 

ringnumbers 
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Menu-Item Help 
 

Contents 

About 

 

Master index 

File 

Pigeons 

Results 

Breed 

Extra 

Settings 

Help 

FAQ 
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About 
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FAQ                                                                                                   Masterindex 

 

 

  Page 

 Registration file menu only, Security, indexing and help visibly 110 

 Errors in Compustam 2020 with Windows 7 operating Systems 111 

 Windows 7 support ends on 14 januari 2020  

 Errors in Compustam 2020 bwith Windows 8.1 operating Systems 113 

 Errors in Compustam 2020 with Windows 10 operating Systems 116 

 Possible error message after upgrading from Windows 7 or 
Windows 8.1 to Windows 10 

119 

 How do I start making a new tree 122 

 How do I start making a new tree 123 

 I enter the parents, but i do not see them on the tree 123 

 I get the year 2099 instead of 1999 124 

 I get an English-language error message when I want to go to a subject 124 

 If I print lists there are columns outside the paper 124 

 I cannot find the pigeon with the search option 125 

 Buttons 126 

 Grafieken  

 Week month calender 127 

 Pigeon data Tab basic data 128 

 Pigeon data Tab Purchase/sale 129 

 Pigeon data Tab Diary 130 

 Print 131 

 Add new race, cooler, breeder, pigeon, code, Country 132 

 A backup or restore to a USB stick how do you do that? 133 

NEW!!! Exchange data to a USB stick how do you do that? 134 
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Registration file menu only, Security, indexing and help visibly             FAQ 
 
There are 2 possible causes that prevent you from entering the menu items 

 
If these options do not offer any improvement, please make a 'security data' and contact us via 
the email address below. Mention your member number-name-address-details-telephone-e-mail 
address Describe your problem and also send the file 'security data' (Winstam9.bck) with the e-
mail as an attachment  
 
Send the problem file to Compuclub (e-mail) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1st Compustam 2020 is the last time incorrectly closed. Some files have been corrupted 

You must now first 'index files' in with menu item File run to repair the files of Compustam 

2019. 2nd It is also possible that an incorrect registration file has been loaded. Please re-

enter the data of the registration form into Compustam 2020  that you received at the 

Compustam 2020 -Cd You can not use a registration file of another version 
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error messages in Compustam 2020 Windows 8.1 operating 
system                                                                                     FAQ 

 
The following error messages may occur in Compustam 2020 for Windows 8.1  
1. In the making of a protection, the following error may occur the message eg 30/05/2019 is not 
a valid date if you want to restore. backup  

2. When requesting performance, the same error message will be displayed. eg 30/05/2019 is 
not a valid date.  
 

 

The solution for Windows 8.1 operating systems 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Type “Control “and press enter following screen appears 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

click on clock language and Region  

 

Skip Windows 8.1 Metro interface  

In Windows 8.1 you can directly go to 
the desktop like in Windows Vista and 
Windows 7  
Right-click any ware on the taskbar 

and choose Properties 

 

 
 

Click the tab navigation and click 

under the heading Home screen. 

Now the Metro interface on 

Windows 8.1 will be beaten Do not 

forget to click Apply 
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error messages in Compustam 2020 Windows 8.1 operating 
system                                                                                          FAQ 

 
following screen appears 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click on Region following screen appears 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Important: Make sure your login to Windows 7 T.M Windows 10 with administrator 

rights than you have permission to remove or install Windows programs 
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1 klik on date  
2.take oved dd-MM-yyyy 
3. click on aply 
4. click on ok  
5. click on apply then ok 2x  
6 imported start the pc or laptop again otherwise it will not work  
 
 
 
 
 
 
 
 
 
 
 

error messages in Compustam 2020 Windows 8.1 operating 
system                                                                                          FAQ 

 Reindex Compustam files 

1. Open Compustam  

2. Open menu-item File 

3. Open menu-item index Files 

4. Klik op Start index files 

5. After reindex click close 
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error messages in Compustam 2020 Windows 10 operating 
system                                                                                           FAQ 

 
The following error messages may occur in Compustam 2020  for Windows 10  
1. In the making of a protection, the following error may occur the message eg 30/05/2019 is not 
a valid date if you want to restore. backup  

2. When requesting performance, the same error message will be displayed. eg 30/05/2019 is 

not a valid date 

 

 

 

 

 

 

 

 

 

 

2. Type ‘CONTROL 'PANEL' and press Enter  

following screen appears 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Searching in Windows 10 has 

been changed Now you can not 

only search for files or folders, but 

also directly to the Internet (for now 

Bing is not to change) If you do not 

see the Web option click sprocket 

no. 2 and switching search online 
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error messages in Compustam 2020 Windows 10 operating 
system                                                                                    FAQ 

 

3. clock language and region to the following screen appears 

 

 

 

 

 

 

 

 

 

 

 

 

Click on Region 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note the short 

time 

designation is 

set correctly dd-

MM-yyyy 
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error messages in Compustam 2020 Windows 10 operating 
system                                                                                       FAQ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 klik on date  
2.take oved dd-MM-yyyy 
3. click on aply 
4. click on ok  
5. click on apply then ok 2x  
6 imported start the pc or laptop again otherwise it will not work  
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Possible error message after upgrading from Windows 7 or Windows 8.1 to 
Windows 10 

 

After upgrading from Windows 7 or Windows 8.1 to Windows 10, the following error can occur 

during startup of Compustam 2020 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This is because there is no default printer set in Windows 10. To resolve this by clicking the 

Windows Search button, Type Control Panel, then Hardware and Sound 
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Possible error message after upgrading from Windows 7 or Windows 8.1 to 
Windows 10 

 

 

Go to Devices and Printers 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click on one of the printers printers to right and set it as the default printer 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tip: This can also occur in Windows 7 or Windows 8.1 eg after an update of a printer 

driver. Follow the same steps in Windows 8.1 and Windows 7 click on the start button 

and go to printer devices, and to set a printer as the default 
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Possible error message after upgrading from Windows 7 or Windows 8.1 to 
Windows 10 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Tip: This can also occur in Windows 7 or Windows 8.1 eg after an update of a printer 

driver. Follow the same steps in Windows 8.1 and Windows 7 click on the start button 

and go to printer devices, and to set a printer as the default 
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How do I start making a new tree                                                              FAQ 
 
Suppose you want to enter a new tree of a dove. Unlike previous versions, there is now an 
easier way to fill the pedigree. fill example the (boy) pigeon data inch ringnr parents. You then 
click on the "Calculate" button you will see a green screen. Where the boxes are white with red 
ringnrs you can double-click, you can then proceed to fill in the data and then close that window 
by means of the cross right window. This repeat until the tree is filled completely. You must 
when editing the data pigeon ringnrs parent already enter then you can get them off of pedigree 
double-click to edit the dove further  
In the old way, you can of course they still fill as listed below 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This example pigeon has a pedigree of four generations.  
Generation 1: pigeon itself (young) 1x Generation 2: Parents (father - mother) 2x Generation 3: 
Grandparents (grandpa granny paternal grandfather grandmother Mothers side) 4x Generation 
4: About Grandparents (father, mother, grandpa, father-mother grandmother) 8x  
see example below:  
 

Back to FAQ 
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How do I start making a new tree                                                              FAQ 
 
Then follow the steps below.  
• 1. Start Compustam on.  

• 2. Click on "Pigeons"  

• 3. click on "Pigeons data"  

• 4. Click on the button "Add"  

• 5. Enter the full pigeon data. Click HERE for a description  
 
Start entering as ringnr 0000001 in example pedigree. Then with 0000002, 0000003 etc. If you 
are at Ring number 0000009, you can search the parents there, because you have already 
entered. Looking for the parents do through the binoculars see example below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Tip: It is best to proceed in this manner through the binoculars to look up the pigeons. If you 
directly type the pigeons go wrong and no good strain bean shown. If you look up the birds with 
binoculars, the link is made well and also display the country codes directly and the good of it as 
a tree also makes use. Good country codes If you have entered this country codes once good 
and you make with one or more pigeons loft list then they're even good to use for your 
electronic click. see the following sections for more information  
Back to FAQ 
 

I enter the parents, but i do not see them on the tree                              FAQ 
 
This is often a mistake when entering the parents. Here are some tips: 
 
 
 
 
 
 
 
• In the edit screen pigeon data is probably an incorrect country code among parents in the 1st 
box. So, this is not allowed. Click HERE for further explanation  
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I get the year 2099 instead 0f 1999                                                             FAQ 
 
Your date setting in Windows is not good. Click HERE to see the correct setting. After you create the 
right setting, you must remove the incorrect years (eg 2099). This is done by removing performance  

date.  
Click HERE for more information about removing performance by date 
 

I get an English-language error message when I want to go to a subject 
 

Probably your system has stalled once or there has been a power outage. You can index with ' 
files' in the File menu restore your files. 
 
Click here for more information 
 

If I print lists there are columns outside the paper                                FAQ 
 
You must check the box in the user settings tab fonts. Monitor the correct font If the defect is not 
resolved, you have to install font Orator 10 Pitch Again This font can be found on the installation CD 
Compustam. To install under Windows 95/98 this font, insert the CD into your CD-ROM on the main 
screen of the Windows "Start" button bottom left of the screen. Then go to Settings - Control Panel - 
Fonts  

Look at the list of fonts or font "Orator 10 Pitch BT" already exists. If the font already exists 
should be by right-clicking on them first removed and in the menu, that pops open "Delete" 
button. Then confirm by clicking. "Yes" to  
Select the top of the screen "File" and then "Install New Font" Select at stations for your CD-
ROM letter designation (usually D or E) Double in folders on the FONTS folder  
In "List of fonts" top of the screen "Orator 10 Pitch BT (TrueType)" is displayed. Click this font 
and then press "OK". You can now check "Orator 10 Pitch BT" is indeed added to the window 
with the fonts.  
In Compustam for Windows you now have the ability to set large so your lists remain within the 
paper.  
Font in Settings Tip: 
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I cannot find the pigeon with the search option                                       FAQ 
 
Through the binocular you can look up the pigeon in the file. This is done by the last three digits 
of the number ring types.  
 
Tip: If you enter the last 3 digits but the pigeon is still not to set the search function on from 
1900 sex:  
all selection pigeon code OFF (unchecked)  
Start selection  
then select the appropriate dove right as Compustam several pigeons find and click OK 
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The main buttons in Compustam  
Confirm and 
close  

Copy pigeon 

1 

Cancel 
 

To notes 

 
Add information 

 
Save data 

 
Delete data 

 
Print data 

 
Edit data 

 
Brouse data 

 
Find data 

 
  

    

Buttons                                                                                                          FAQ 
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Week month Calender                                                                                FAQ 
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Tab Basic data                                                                                              FAQ 
 

Here you can, add, delete data from the pigeon. can be accessed via menu – items: Pigeons> 

Pigeon Data 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tip: It is best to proceed in this manner through the binoculars to look up the pigeons. If you 

directly type the pigeons go wrong and no good strain bean shown. If you look up the birds with 

binoculars, the link is made well and also display the country codes directly good 
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Tab Purchase/sale                                                                                        FAQ 
 

With the purchase / sale tab you can immediately see where the dove is gone or where you got 

the pigeon. For proper administration, there is also the possibility amount, date, order no and 

order code to enter. 
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Tab Diary                                                                                                       FAQ 
 

You can immediately see all the events on the diary tab that relates to the pigeon. The "Journal" 

button, go to the diary of the selected event / activity where you can change or add data to. 
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Print                                                                                                                FAQ 
 

Before you print something, you can set different options 
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Add new breed, color, breeder, pigeon Colour, Country                          FAQ 
 

To additions of various colour pigeon breeder code or country code to do first go Will you go to 

menu item Pigeons then click eg add the following screen 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can now directly new race, colour, pigeon breeder code and country to adding the pull-

down menu, click on new. 
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A Backup or restore to a USB flash drive How do you do that?             FAQ 
 

A backup or restore on a USB stick is fairly easy, but you do have to think about the following 

things. If you have booted Compustam connect it off through menu item File, then close or click 

once on the red X in the upper right screen.  

 

Insert your USB drive into your PC or laptop and wait for the USB stick is visible, the drive letter 

may vary by PC or laptop  

 

Start Compustam and go to menu item File> Backup Data> Backup 

  

 
 

The following screen appears 

 

 

In the bottom bar, you can through the triangle to select the correct drive letter (in this case, E: \)  

But it can also be a different drive letter varies by PC or laptop  

 

If you have selected the correct drive letter (USB stick), click Start Security  

Back-up system is the same way but then choose  

File> Data Security> Security restore 

 

 

 

 

Create security on a USB stick  

Insert the USB stick and wait until it is visible. Follow the instruction data security. Note: 

Looking at the bottom bar on your USB stick, you can now create a security or set back 
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Exchange data to a USB stick how do you do that?                                  
FAQ 

 

Exchange data (pedigree) on a USB stick is fairly easy, but you do have to think about the 

following things. If you have booted Compustam connect it off through menu item File, then 

close or click once on the red X in the upper right screen.  

 

Insert your USB drive into your PC or laptop and wait for the USB stick is visible, the drive letter 

may vary by PC or laptop  

 

Start Compustam and go to menu item File> Exchange Data > Export Pedigree Data 

  

 
The following screen appears 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Create security on a USB stick  

Insert the USB stick and wait until it is visible. Follow the instruction data security. Note: 

Looking at the bottom bar on your USB stick, you can now create a security or set back 

In the bottom bar, you can through the 

triangle to select the correct drive letter 

(in this case, E: \)  

But it can also be a different drive letter 

varies by PC or laptop  

 

If you have selected the correct drive 

letter (USB drive), you can choose to 

export the tree by pigeon this bird you 

can look in your pigeons by using the 

search button (verrelijker) and Start 

Writing button.  

The bottom option Pigeon code then 

you can select a pigeon code and 

export these pedigrees at once  

(If you are growing for someone else eg 

see tips and tricks of Compustam)  

Import data (pedigree) is the same but 

choose  

File> Data Exchange Data> Import 

pedigree 
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Service Compuclub                                                            FAQ 

 
Make sure you if you contact Compuclub you to hand the following information:  
-The correct version number for Windows Compustam, so do not Compustam 2018  but 
Compustam 2020 release 9.26 What kind of system do you use? - How Much Is Your Bit OS 
(Windows 7 and Windows 8) What is the exact error message (if applicable-What has changed 
since the last time everything worked-What? Have already done to fix the problem  
in Windows 7, click on start> Control Panel> System and Security> System the screen below 

appears 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

from Windows Start screen type “Control” and press enter, then you click on System and 

Security and then System 
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Service Compuclub                                                                     FAQ 
 

From Windows 10 go to search in Windows 10 as seen in the image below Windows 10 

type "Control panel " and press enter (then click System and Security System then the 

following screen appears 
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Copyright & Disclaimer  
 
© Copyright  
This is a publication of Compuclub, November 2020 
No part of this publication may be reproduced without the permission of Compuclub  
 
The Compuclub reserves the right to make changes and improvements without notice 
Compuclub cannot be held liable for damage or injury resulting from misuse or use not in 
compliance with the instructions in this manual.  
 
mark  
All names and logos in our manuals are the property of Compuclub, unless otherwise indicated. 
Without written permission from Compuclub. it is not permitted to use these marks.  
 
PDFs  
PDF files may be downloaded for personal use and not printed and distributed without 
permission by e-mail Compuclub  
 
Linking to this site  
It is permitted after our consent by e-mail only to link to the homepage of our website. Direct 
linking is not recommended for a page because Compuclub reserves the right to change the 
structure of the website at its discretion.  
 
Disclaimer  
Compuclub pays the utmost attention to her instructions to make the information as complete, 
accurate, current and accessible as possible. However, we cannot guarantee the accuracy, 
integrity or quality. There is no guarantee or explanation given, either express or implied, 
concerning the fairness, accuracy or completeness of the information published on the manuals 
or to which access is provided through the manuals. Any liability for any damage resulting from 
access to and use of the manuals is emphatically disclaimed by Compuclub. No guarantee is 
given for the faultless and uninterrupted functioning of the manuals. Information from these 
manuals may not be reproduced without written permission  
 
Suggestions, questions or comments about the content of the manuals we appreciate. You can 
submit them by email using our contact us. 
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